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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skarmen.
Tag den tid du behgver for at lese vejledningen,
inden du bruger skaeermen. Den indeholder
vigtige oplysninger om bemeaerkninger angdende
brugen af din skaerm.

Philips garanti deekker under forudsatning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer; justeringer
eller fremgangsmadder, der ikke er beskrevet |
denne dokumentation, kan resultere | elektrisk
sted, elektriske ulykker og/eller mekaniske
ulykker.

Lees og felg disse vejledninger, nar du tilslutter
og anvender din computerskarm:

Betjening
* Hold skeermen vak fra direkte sollys og
veek fra breendeovne og andre varmekilder.

* Fern alt, der kan risikere at falde i
ventilationsabningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

* Bloker ikke ventilationsabningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til stremstikket
og stikkontakten.

* Huvis der slukkes for skeermen ved at fjerne
stremkablet eller jeevnstremsledningen,
skal du vente 6 sekunder, for du sztter
strgemkablet eller jeevnstremsledningen til
igen for at opnd normal betjening.

e Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

» Udset ikke skermen for kraftige
vibrationer eller stazd under anvendelse.

* Sl3 ikke pa skaermen, og undga at tabe den
under brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du
undgd at trykke kraftigt pa LCD skarmen.
Nar du flytter din skaerm, sa tag fat
om rammen for at lgfte den. Loft ikke
skeermen ved at sztte din hand eller fingre
pa LCD skarmen.

» Tag stikket ud fra skaermen, hvis du ikke
skal bruge den i en lzengere periode.

» Tag stikket ud at kontakten til skeermen,
hvis du skal renggre den med en let fugtet
klud. Skeermen kan terres af med en tor
klud, ndr der er slukket for strammen.
Under alle omstendigheder, md der ikke
bruges organiske oplgsningsmidler til
renggring af din skaerm.

* For at undgd risiko for elektrisk stad eller
permanent beskadigelse af anleegget, ma du
ikke udsatte skaermen for stev, regn, vand
eller miljger med hgj fugtighed.

* Hvis din skeem bliver vad, skal den tgrres af
med en ter klud sa hurtigt som muligt.

* Hvis der kommer fremmed substans eller
vand ind i skeermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skarmen til servicecenteret.

* Skzermen ma ikke bruges eller opbevares pa
steder, hvor den udsettes for varme, direkte
sollys eller ekstrem kulde.

* For at opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skeermen et sted, der
er indenfor fglgende temperatur- og
fugtishedsomrade.

* Temperatur: 0-40°C 32-95°F
* Fugtighed: 20-80 % RH



*  VIGTIGT: Segrg altid for at aktivere
en pauseskaerm, der bevager sig, ndr
skermen efterlades uden at blive anvendt.
Du skal altid bruge en pauseskaerm
eller et andet program, der opdaterer
skaeermen regelmaessigt, hvis skaermen
viser statisk materiale i leengere perioder.
Uafbrudt visning af et stilbillede over
lengere tid, kan fordrsage “brandmearker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skaermen.

(AT

“Breendmaerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
fenomen i LCD skaermteknologi. | de
fleste tilfeelde vil “brandmerkerne” eller
“efterbilledet” eller “spggelsesbilledet”
forsvinde gradvist, efter skeermen er
blevet slukket.

O Advarsel

Alvorlig “brandmeerkerne’- eller “efterbillede’-
eller “spagelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennzvnte skade
er ikke dakket af garantien.

Service
e Kabinettet ma kun abnes af kvalificeret
servicepersonale.

* Hvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
“Kundeinformationscenter”)

* For oplysninger om transport, se
“Tekniske specifikationer”.

* Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

& Bemark

Kontakt en servicetekniker, hvis skaermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal gare, nar betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Folgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes |
dette dokument.

Bemarkninger, forholdssregler og advarsler

| hele denne vejledning kan tekstafsnit vaere
ledsaget af et ikon, og sta med fed eller kursiv
skrift. Disse afsnit indeholder bemaerkninger og
punkter, hvor der skal udvises forsigtished, eller
advarsler. De anvendes som fglger:

& Bemark

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan ggre bedre brug af
computersystemet.

(1 Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader; og
hvordan dette undgas.

Visse advarsler kan optrede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmeassigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/
sustainability/recycling.




; B4 Installation af stander
2. Opsatnlng af skaerm 1. Anbring skeermen med forsiden vendt

nedad pa en bled og jeevn overflade, og vaer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

1 Emballagens indhold

%i‘cfart

PHILIPS

]I B 2. Hold pa foden med begge hander, og st
e med en fast hdnd foden ind i fodsgjlen.

(1) Fastsger forsigtigt foden til fodsgjlen
indtil ldsen laser den pa plads.

(2) Brug dine fingre til at fastspaende skruen
under foden, og serg for at foden er
ordentlig fastspaendt pa sgjlen.

VGA (valgfri) DVI (valgfri)




2. Opsatning af skerm

Bl Tilslutning til PC
Model 227E3L:

PHILIPS

o e
N =Hi= v
O /c strgmindgang
(2] VGA-indgang
O DViD-indgang
Kensington anti-tyverisikring
Model 227E3LH:
000 0
oms
=16 &
(6]

O /C stremindgang
(2] VGA-indgang
DVI-D-indgang
O HDMiindgang
Lyd-indgang
Lydudgang
Kensington anti-tyverisikring

Model 227E3LPH:

PHILIPS

O /c stremindgang
(2 VGA-indgang
O DVI-D-indgang

HDMI indgang

© HDMi lydudgang

Kensington anti-tyverisikring

Tilslutning til pc

1.

W

>

Tilslut ledningen ordentligt pa bagsiden af
skaermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pa computeren.

Seet computerens og skeermens
netledninger til et stik i nerheden.

Taend for computeren og skaermen. Hvis
skermen viser et billede, er installationen
gennemfort.



2.2 Brug af skaerm

( 7E D \
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Kl Produktbeskrivelse set forfra
Model 227E3L:

(5]
/v ©/a 1/ < /0K )
I I [\ | |
(7] (6 o O (2] o

Model 227E3LH:

15
/v ©/A 10/< /0K 0)
| | [\ | |
7 (6] © © (2] (1]
(1) () | Tender og slukker for skermen.
Sadan far du adgang til OSD-
® S/0K menuen.
G4 tilbage til det forrige OSD-
o < niveau.
O 1 |juster lydstyrken.
© | A V¥V [Tiljustering i skermmenuen.
O © (Skiftertilslutningskilden.
Smartlmage Lite. Der kan velges
@ @ |mellem tre funktioner: Standard,
Internet og Game (Spil).

Model 227E3LPH:

(1] () |Tender og slukker for skaeermen.
Sadan far du adgang til OSD-
9 3/0K menuen.
(a4 tilbage til det forrige OSD-
o < niveau.
O [0 [Skift til 43 format.
© | AV [Tiljustering i skermmenuen.
O  © Skiftertilslutningskilden.
Smartlmage Lite. Der kan veelges
B |mellem tre funktioner: Standard,
o Internet og G. '
g Game (Splil).

(5]
/v ©/A SENSOR/ < /0K )

I I [\ | I
(7] (6] © 6 o (1]
(1) () | Tander og slukker for skermen.

Sadan far du adgang til OSD-
® B/0K menuen.
G4 tilbage til det forrige OSD-
o < niveau.
Indstil sensorniveauet pd den
© | SENSOR |automatiske justering af bag-
grundslyset.
© | A V¥V [Tiljustering i skermmenuen.
O ©® (Skiftertilslutningskilden.
Smartlmage Lite. Der kan velges
a B> |mellem tre funktioner: Standard,
Internet og Game (Spil).




2. Opsatning af skerm

E1 Beskrivelse af OSD-visningen

Hvad er OSD (On-Screen Display)?

Visning pa skeermen [On-Screen Display
(OSD)] er en funktion pa alle Philips LCD
skerme. Den satter en slutbruger i stand

til at justere skaermindstillingerne, eller

veelge skermens funktioner direkte via et
instruktionsvindue pa skaeermen. Et brugervenligt
skaermvisningsinterface vises som nedenfor:

Model 227E3L:

s VGA |
&= Input s
a \

Model 227E3LPH:

-)) Power Sensor

Grundlzggende og enkle anvisninger til
kontrolknapperne

| skeermmenuen ovenfor, kan du bruge

V¥ A knapperne foran pa skaermen til at flytte
markeren med, og tryk pa OK knappen, til at
bekreefte dit valg eller zendring.

OSD-menuen

Nedenstdende er en generel oversigt over
strukturen i OSD-displayet. Du kan anvende
den som opslag, nar du senere skal orientere
dig i de forskellige justeringer.

Main menu Sub menu
Power Sensor I: On — 0~4
Off
(available for selective models)
— VGA
Input
—— DVI (available for selective models)
L— HDMI (available for selective models)
— Picture Format — Wide Screen, 4:3
Picture
— Brightness — 0~100
— Contrast — 0~100
L SmartR __ Off, Fast, Faster, Fastest
martResponse (available for selective models)
L— SmartContrast — On, Off
— Volume — 0~100 (available for selective models)
Audio
— Stand Alone — On, Off
— Mute — On, Off
r— Color Temperature — 6500K, 9300K
Color
— sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
Language — English . Espaol, Frangais, Deutsch, Italiano,

Portugués, Pycckuii, fEJRFSL, Turkge

OSD Settings — Horizontal — 0~100
— Vertical — 0~100
[ Transparency — Off,1,2,3,4
— OSD Time out — 5,10, 20, 30, 60
Setup — Auto
— Power LED — 0,1,2,3,4
— Over Scan —— On, Off (available for selective models)
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
L— Information




El Meddelelse om oplasning

Denne skaerm er fremstillet til optimal ydelse
pa dens native oplgsning, som er 1920 x 1080
@ 60 Hz. Nar skeermen bruger en anden
oplasning, ses falgende advarsel pd skaermen:
Brug 1920 x 1080 @ 60 Hz for at opna det

bedste resultat.

Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i
OSD (skaermmenuen).

4 Fysisk funktion
Vip

2.3 Fjern standeren og foden

1 Fjernelse af foden

Inden du begynder at adskille skaermens fod,
skal du felge vejledningerne nedenfor for at
undgd mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jevn overflade, og veer
forsigtic med ikke at ridse eller beskadige
skaermen.

2. Fjern foden fra sgjlen, ved at:

(1) Bruge dine fingre til at lasne skruen pa
bunden af foden.

(2) Treek langsomt foden op og ned for
at abne lasen, der fastholder foden, og
treek langsomt foden af sgjlen.




2. Opsatning af skerm

2. Fijernelse af foden

1. Du kan bruge en almindelig skruetraekker
til at stikke ind i de to frigivelseshuller pa
heengslet, og lirk forsigtigt i haengseldakslet
for at flerne det.

2. Hern de 4 skruer og fiern derefter foden
fra skaermen.




3. Billedoptimering

3.1 Smartlmage Lite

K} Hvad er dette?

Smartlmage Lite er forudindstillede indstillinger,
der optimerer skeermen | henhold til indholdet,
og som indstiller den dynamiske lysstyrke,
kontrast, farve og skarphed i realtid. Uanset om
du arbejder med tekstprogrammer, ser billeder
eller ser video, sa giver Philips Smartimage Lite
den optimale skarmydelse.

B} Hvorfor behgver jeg det?

Du gnsker en skaerm, som giver det bedste
billede for alle typer indhold. For at @ge skeerm-
oplevelsen, indstiller Smartimage Lite-softwaret
dynamisk lysstyrke, kontrast, farve og skarphed

| realtid.

El Hvordan virker det?

Smartimage Lite er en eksklusiv, ferende
Philips-teknologi, som analyserer indholdet pa
skermen. Ud fra det valgte scenarie forbedrer
Smartlmage Lite dynamiske billeders og
videoers kontrast, farvemaethed og skarphed for
at forbedre det viste billede - alt i realtid og blot
med et tryk pd en knap.

Bl Hvordan aktiveres Smartlmage Lite!?

(- —)

</

PHILIPS

1. Tryk Y pa for at starte Smartlmage Lite
pa skaermen;

2. Tryk gentagende gange pd BD for at skifte
mellem Standard, Internet og Game (Spil).

3. Smartlmage Lite ses pd skaermen i fem

sekunder; men du kan ogsa trykke pa OK
for at bekreefte det.

4. Nar Smartlmage Lite er aktiveret,
deaktiveres sRGB systemet automatisk.
For at bruge sRGB skal du deaktivere
Smartlmage Lite med B foran pa
skaermen.

Udover at bruge BD il at rulle ned med, kan
du ogsa trykke pa ¥ A for at veelge og derefter

trykke pd OK for at bekreefte valget og derefter
igen lukke Smart-billede OSD.

Der kan velges mellem tre funktioner: Standard,
Internet, Game (Spil).

@ Smartlmage ™

Standard

Internet

» Standard: Forbedrer teksten og demper
lysstyrken for; at @ge leesbarheden og
nedsette anstrengelsen af gjnene.
Denne funktion gger leesbarheden og
produktiviteten, nar der arbejdes med
regneark, PDF filer, skannede artikler og
andre generelle kontorprogrammer.

* Internet: Denne funktion kombinerer
farvematheden, den dynamiske kontrast
og skarphed for at vise billeder og lignende
klart og i levende farver - alt uden synlige
fejl pa det skannet billede og blegnede
farver.

*  Game (Spil): Aktivér overdrive-kredslgbet
for at fa den bedste reaktionstid,
reducere skaeve kanter pa genstande, der
bevaeger sig hurtigt pa skeermen, forbedre
kontrastforholdet mellem lyse og merke
omrader. Denne funktion giver brugeren
den bedste spilleoplevelse.



3.2 SmartContrast

K} Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skeermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
demper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pa en merk
baggrund.

Bl Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, lzesbar tekst ved kontorarbejde.Ved at
nedsatte skeermens strgmforbrug, sparer du
energiomkostninger og forlenger skaermens
levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og
baggrundslysets intensitet indstilles. Denne
funktion forbedrer den dynamiske kontrast og
giver saledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.3 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skeermen
via et nemt, grafisk interface. Komplicerede
justeringer hgrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af opl@sning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er

udstyret med den seneste teknologi i algoritmer

for hurtig behandling og reaktion, og er tilmed
Windows 7 kompatibel, og klar til at forbedre
din oplevelse med Philips-skaerme!

El Installation

* Folg instruktionen og fuldfer installationen.
* Du kan starte, nar installationen er fuldfert.

* Huvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
verktgjslinjen.

PHILIPS wwew.philips.com/welcome

Raquired sxeps Monitor driver and software installation
Spstem requirements:
+ PC running Windows 7, Visms, XP, 2000, 98.

+ Go to wwwphilips.com/welcome o downlead the lacest version of manitor driver

Philips SmartControl
Systom tupport and requirements:
1. System support Windows 7, Vista, XP.

L Language support English, German, Spanish, French, Italisn, Russian. Portuguese. Simplified Chinese
3. Philips Monicor Plug and Pay support

»Goto

Opstartsguide

* Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet fgrste gang.

*  Guiden leder dig trin for trin gennem
indstillingen af skaermen.

* Du kan ogsd g2 til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.

* | Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.

1 smartControl 2 - Philps 22581 (CS30715000001) (2)X
SmartControl Lite PHILIPS

Wizard
You'l need to calibrate your display to get the most
accurate color. We encourage you to use the simple

tuning process by selecting the Start Wizard button.
This pracess involves a series of steps that wil let you

] tune your disply and save the settings.
| 1. Choose the Start Wizard button.
2. Follow the steps outlined in this process.
0 3. Save your settings for future use.

Adiust Audio

\g Auto Piot
e

Color Input

= &
\Q Wizard
: B
‘Options

Presets

\g Mutti Monicors

Help

Start Wizard



3. Billedoptimeri

F1 Start med Standard-vinduet:

" W smartControl

SmartControl Lite

Adjust menu (Indstillingsmenu):
* Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),
Contrast (Kontrast), Focus (Fokus), Position
(Position) og Resolution (Oplasning). A

Brightness

«  Udfer indstillingen ved at fglge = o

instruktionerne.

e |nstallationen kan annulleres med Cancel

(Annuller).

B SmartControl

SmartControl Lite

Adiust Q

Brightness

G

Contrast

Color 2
~

Focus

Position

ODﬁu;\s F;

Resolution

3

Help

B SmartControl

SmartControl Lite

Adijust )

Brightness

Contrast

a
B 1%

o
g
a
&

o
2
a
5
5

Options

g Resolution
Help

Contrast

Color %

e Focus

Position

Options FF

Resolution
2 - Philips 225B1 (C530715000001)

PHILIPS

Help

Brightness

Improperly adjusted Brightness wil resuit in 3 loss of
detail in darker image areas. Adjust the Brightness for
the best possble picture quality.
1. Lower the Brightness to the minimum level.
2. Raise the Brightness to the desired level.
3. Adiust the Brightness as needed to achieve
an equal separation of the stripes.

" W SmartControl

SmartControl Lite

Brightness 100
= ot
Adiust

undo Reset

Brightness

Color ~a

Options ps

Resolution
2 - Philps 22581 (C530715000001) £%](X) \g
PHILIPS
Help

Contrast

Adjust the Contrast (use the sider) to keep detaiks in
lighter image areas.
1. Raise the Contrast unti the numbers 1 and 2
are no longer visible.
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visible.

W SmartControl

SmartControl Lite

Contrast 50
= o ®
Adjust Q)
Undo Reset X
Brightness

Options ﬁ

Resolution

Help

12

2 - philips 22581 (€s30715000001) ¥} X,
PHILIPS

Focus

Your display’s timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are still visble, you'l need

o adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen.

Pitch 50

= )

Phase 17

= o
Undo Auto Setup

2 - Philps 22581 (cS30715000001) (%} X

PHILIPS

Position

Use the Position buttons ta center the image on
your display. Using this tool, you can position the image
up, down, left, or rig

1. Use the Up/Down buttons to center the image

vertically.
2. Use the Left/Right buttons to center the image
horzontally.
Undo Reset

2 - Philps 22581 (C530715000001) i F}(X
PHILIPS

Resolution

You are currently 3t a Preferred resolution. For your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resolution.

1f your display is 3t a Non-Preferred resolution, click
on the Preferred button to change your resolution to
Preferred.

I™ Enable Resolution Notifier

Picture Format
I™ 4:3 aspect ratio

Preferred




3. Billedoptimering

Color menu (Farvemenu):

Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration
(farvekalibrering) og Smartimage Lite (se
afsnittet Smartlmage Lite).

Udfer indstillingen ved at folge

instruktionerne.

Se nedenstdende oversigt med
undermenupunkter baseret pa din

indtastning.

Eksempel pa Color Calibration

(farvekalibrering):

" | SmartControl

SmartControl Lite

&

Adiust RGB
Eb&vel
Wh rte- Point

Display Gamma

-yl

Options Caibration

il

ap

Smartimage

g@

B SmartControl

SmartControl Lite

RGB
Black Level

wh le Point

Display Garmma

L

Options Calibration

ap

Smartlmage

%
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Black Level

Improperly adjusted Black Level wil result in 3 loss of
detail in darker image areas. Adjust the Black Level for
the best possble picture quality.
1. Adjust the black level of the Red, Green, and
Blue using the sider bars.

Red 50

o “ e

Green 50

o] o v

Blue 50

o v w7
Unda Reset

2 Philps 22581 (C530715000001) (%)%,
PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at full intensity create
white. This effects the overal color quality. For the
most accurate colors click the Reset button then
selact the White Point.
1. Please select the White Point value for the best
possible color guality.

white Point 6500K
= QO e

Unda Reset
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SmartControl Lite

SmartControl Lite
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Display Gamma

Ganmma £ a cog

To adjis mage st bt sot to OfF
Cick the ff Button before adjusting
Garim
. 1. Use the skder to sslect the desred Gamma
Disck Lavel

w
Y

Whita Pont Dsplay Gamma

: th'glm 50 80l

A 1
. ) Unde Rasat

+

Options Galbration
ot ap
Srrarthrage
Hulp
W St Contiol 2 - Philps 22581 (€530715000001) [T
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Calibration

‘Your display needs to be properly calibrated n order
for it to produce the widest range of colons accurstedy.
Calibration should always take place as the Bt tuning
step In the process. Remember to recalbrate any tme
vou make indwidual adjustments to image quality or
whenever you move your dipley to 2 new location.

L. Make 2l other necessary adjustments to mage
I qualky first.
EGR 2. Press Show Me to leam how to use the

calibration took.
3. Finally, press Start to begin the calibration

process.
Black Level
i ¥ Enable color calbration
Color software designed in coliboration with Joseph
Holmes.
Vihita Ponit Protected by 115, Patent Ho, 6,685,953

Display Gamera
w,
Calbration
ap

Smartimage

Show Me Start

Quick View

“Show Me" (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleser far/
efter-billederne.

For at vende tilbage til Color (Farve)
vinduet, skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfgre en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

Der skal veere patentoplysninger pa
kalibreringsskaermen.



3. Billedoptimering

Forste farvekalibreringsskaerm:

rullemenuen. P4 en ikke-understgttet skerm
med DDC/CI er kun Help (Hjalp) og Options
(Funktioner) til radighed.

* @ smartcontrol 2 - Phips 22581 (CS30715000001) (2%, |

SmartControl Lite PHILIPS

*  Previous (Foregdende) knappen er
deaktiveret, indtil du gar videre til den
anden farveskaerm.

* Next (Naste) gar til efterfelgende mal
(seks mal).

» Ga til sidst til File > Presets (File > Forvalg)
vinduet.

* Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden.

Smartlmage Lite

Smart-Billede - tillader brugeren at a&ndre
indstillingerne, for at opnd en bedre
skermindstilling baseret pa indholdet.

Nar der indstilles pd Entertainment
(Underholdning), aktiveres Smart-Kontrast og
Smart-Svar

* {8 smartControl ETEIN
SmartControl Lite PHILIPS
SmartImage
SmartImage provides different brightness and
contrast levels to accomodate today's wide range of
computer applications.
e | Choose the setting that is most comfortable or
| efficient when viewing your application. Alternatively,
B '! simply choose the one that best describes its type.
Adjust RGE
Black Level
Color White Point

g =
Display Garmma
Q !

Calibration

(o] ]

Internet Standard

Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, ndr Preferences
(Indstillinger) er valgt i Preferences (Funktioner)-

14
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Preferences

You can use the following options to configure
SmartControl.

¥ Enable menu when right-clicking on desktop
¥ Enable task tray menu

¥ Run at system start-up

Set Transparency:

@ 0% © 50% © 100%

Pre!mn ces

Audio

Auto Pivot

Adjust
e
Color Tnput
e .
Help

L~ S
i Wizard
2

Options Presets

‘Q Multi Monitors

Viser nuvaerende, foretrukne indstillinger.

Funktionen aktiveres ved at afmearke feltet.
Afmerkningsfeltet er en flip-flop.

Enable Context (Aktiver Indhold) menuen
er som standard afmeerket (Til) pa
skrivebordet. Menuen Enable Context
(Aktivér kontekst) viser valgmulighederne i
SmartControl Lite pa Select Preset (Velg
Forvalg) og Tune Display (Indstil Display)

| genvejmenuen ved at hgjreklikke pa
skrivebordet. Disabled (Deaktiveret) fierner
SmartControl Lite fra genvejsmenuen.

Enable Task Tray (Aktiver Jobbakke)

menuen er som standard afmeerket (Til)
pa skrivebordet. Menuen Enable Context
(Aktiver Indhold) ger, at systembakkens
ikon til SmartControl Lite vises. Et hgjreklik
pa jobbakke-ikonen viser menufunktionerne
for Help (Hjeelp), Technical Support
(Teknisk Support), Check for Upgrade
(Tjek efter opgraderinger), About (Om) og
Exit (Afslut). Nar Enable Task Tray (Aktiver
Jobbakke) menuen er deaktiveret, viser
jobbakke-ikonen kun EXIT (AFSLUT).

Run at Startup (Ker ved opstart) er
som standard afmeerket (Til). Nar den
er deaktiveret, starter SmartControl Lite



3. Billedoptimering

ikke ved opstart og ikonet vises ikke |
systembakken. SmartControl Lite kan

kun startes fra genvejen pa skrivebordet
eller fra programfilen. Intet forvalg, som er
indstillet til at kere ved opstart, indlaeses
nar denne boks ikke er afmerket (er
deaktiveret).

* Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows
7,Vista, XP). Standard er 0%
uigennemsigtighed.

Options > Input (Funktioner > Indgang)

- er kun aktiv, nar Input (Indgang) er valgt i
Options (Funktioner) rullemenuen. Pa en ikke-
understottet skeerm med DDC/CI er kun Help
(Hjeelp) og Options (Funktioner) til radighed.
Alle andre faneblade | SmartControl Lite er ikke
til rddighed.

8 smartcontrol 2 - Phips 22581 (€530715000001) {7)(X

SmartControl Lite PHILIPS

Input

Your display has two inputs (connections on back of
this display) so you can hook up two different sources
at the same time. Use the Analog In and Digital In
buttons to select which source you'd like to view. You
are currently viewing the analog in image.

&

IMPORTANT! If you switch inputs SmartControl may
lose the ability to control your monitor. In this case you
Adjust Audio may have to use the Input Select button on the front
of your monitor to switch back to the original input
before SmartControl functionality can be restored.

D Auto Pivot
Color Input
k
e + 'B
@ oy
, i
Options Presets

Multi Monitors

&

Help

Anzlog In Digital In

* Vis Source (Kilde) instruktionsvinduet og
nuveaerende indgangskildeindstillinger:

* P4 enkeltindgangsskeerme ses dette vindue
ikke.

Options > Audio (Funktioner > Lyd) - er
kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pa en ikke-understgttet skeerm med DDC/CI
er kun Help (Hjeelp) og Options (Funktioner) til
radighed.
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Audio

Adjust the Volume of the integrated loudspeakers by
using the slider.

Tum off the integrated loudspeskers by checking the

- Mute checkbox.
9 ™ Mute
Audio

Adjust
\ﬂ Auto Puot
-
Color Input
> tay k
4
Options Presets
\g Mutti Monitors
o Volume 100
el = @
undo

Help > User Manual (Hjalp >
Brugervejledning) - er kun aktiv, nar User
Manual (Brugervejledning) er valgt i Help
(Hjelp) rullemenuen. P4 en ikke-understattet
skeerm med DDC/Cl er kun Help (Hjzlp) og
Options (Funktioner) til radighed.

1B smartControl 2 - phiips 22581 (CS30715000001) |\ X)

SmartControl Lite PHILIPS

User Manual

If you need help setting up or operating SmartContral,
click the Tech. Support button. You'll have the
option to fil out an Assistance Form.

You can also choose to have information about your

software autormatically attached to the assistance
form. You'll need to be oniine to use this feature.

Adiust ﬂ
. User Manual

@
®

Update

Color
L]
Display ID
System ID

X5

Version

Options

User Manual Tech. Support

Help >Version (Hjelp > Version) - er kun aktiv,
narVersion (Version) er valgt i Help (Hjzlp)
rullemenuen. Pa en ikke-understgttet skeerm
med DDC/Cl er kun Help (Hjzlp) og Options
(Funktioner) til radighed.
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Version

Context Sensitive (Indholdssensitiv) menu

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmarket
i Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

@ SmartControl
Select Preset L4
Tune Display

%
Smnartlmage

Context menuen har fire punkter:

*  SmartControl Lite - nar valgt, ses About
(Om) skaermen.

* Select Preset (Valg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes |
rullemenuen.

* Tune Display (Indstil Skeerm) - abner
kontrolpanelet til SmartControl Lite.

*  Smartlmage Lite - Kontroller nuvarende
indstillinger; Standard, Internet, Game (Spil).

Task Tray (Jobbakke) menu aktiveret

Menuen i systembakken kan ses ved at
hejreklikke pa SmartControl Lite-ikonet
I systembakken. Et venstreklik starter
programmet.

16

Help

Technical Support
Check for Update
About

Exik

Jobbakken har fem punkter:

* Help (Hjzlp) - adgang til
brugervejledningsfilen: Abner
Brugervejledningen med standard
browservinduet.

* Technical Support (Teknisk Support) - viser
siden med teknisk support.

*  Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

* About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

* Exit (Afslut) - Luk SmartControl Lite.
Hvis du vil kere SmartControl Lite igen,
skal du enten valge SmartControl Lite i

programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

SmartControl

PHILIPS

SmartControl
Version 3.20
ctune-standard-R2007-01-04-1151-23
Copryright 1993-2007 Portrait Displays, Inc.
Patents Pending

Task Tray (Jobbakke) menu deaktiveret

Nar Task Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) | Options > Preferences (Muligheder >
Indstillinger).



4. PowerSensor™

(Kun pa 227E3LPH modellen)

PowerSensor er en unik miljgvenlig teknologi fra Philips, som giver brugeren mulighed for at spare op
til 80% af stremforbruget. Ligesom Philips Sense og Simplicity drey, virker denne brugervenlig teknologi
uden at det er ngdvendig at installere hardware eller software, og uden at brugeren skal ggre noget |
standardtilstanden.

Bl Hvordan virker det?
* PowerSensor udsender og modtager harmlase “infrargde” signaler, sa den kan finde brugerens
tilstedeverelse.

* Nar brugeren er foran skaermen, bruges de indstillinger; som brugeren selv har sat, f.eks. lysstyrken,
kontrasten, farver osv.

* Antages det for eksempel, at skeermen var sat til 100% i lysstyrke, og brugeren forlader hans/
hendes sede og ikke lengere sidder foran computeren, sa reducere skaeermen automatisk
stremforbruget til 80%.

Bruger sidder foran skarmen Bruger ikke til stede

Stremforbruget, som er vist ovenfor, er udelukkende til reference.

2] Indstilling

Standard indstillinger

Pa standardindstillingen (indstilling 3), er PowerSensor fremstillet til at finde tilstedeveerelsen af en
bruger, hvis han/hun er mellem 90cm og 110 cm (35,4 og 43,3 tommer) fra skeermen, og indenfor 5
grader til venstre eller hgjre fra skaermen.

Brugerdefinerede indstillinger

* Hvis du ensker at veere et sted udenfor det ovennaevnte omradet, skal du veelge en hgjere
signalstyrke, for at opnd en optimal detekteringseffekt: Jo hgjere indstillingen er sat til, jo sterkere
er detekteringssignalet. For at opnd en maksimal effektivitet og ordentlig detektering med
PowerSensor, bedes du sidde direkte foran skeermen.

* Hvis du veelger at sidde mere 110 cm eller 43,3 tommer vak fra skaermen, skal du bruge det
maksimale detekteringssignal, som har en afstand pa op til 130 cm eller 51,2 tommer: (indstilling 4)

* Da mearkt tgj her en tendens til at absorbere infrargde signaler, selv hvis brugeren sidder indenfor
100cm eller 40 tommer af skeermen, bedes du skrue op for signalstyrken, hvis du har sort eller
merkt te] pd.

* Du kan altid vende tilbage til standardindstillingen (indstilling 3)

17



4. Strgmsensor

Genvejstast Sensor-afstand

PowerSenso = +3

@iV ®/A SENSOR/ 4 /0K [0)

_—

El Sidan justere du indstillingerne

Hvis PowerSensor ikke virker ordentligt indenfor eller udenfor standardomradet, finindstiller du
detekteringen pa falgende made:
* Tryk pd PowerSensor-genvejstasten.

* Herefter kan du se standardindstillingen ‘3" pa justeringsbjeelken.
»  Stil PowerSensor-detekteringen pa 4 og tryk pd OK,

» Test den nye opsatning, for at se om PowerSensor finder dig ordentligt i din nuveerende placering.

& Bemark

En manuelt indstillet PowerSensor vil forblive i drift, medmindre eller indtil den genindstilles, eller hvis
den justeres tilbage til standardindstillingerne. Hvis du synes at PowerSensor er alt for falsom overfor
neerliggende bevaegelser; skal du justere til en lavere signalstyrke.
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5. Tekniske specifikationer

Skarmpaneltype TFT-LCD
Baggrundslys LED
Panelstorrelse 21,5"W (54,6cm)
Billedforhold 169

Pixel pitch 0,248 x 0,248 mm
Lysstyrke 250 cd/m?
Smart-kontrast 20.000.000:1
Kontrastforhold (typ.) 1000:1
Reaktionstid (norm.) 5ms

Optimal opl@sning

1920 x 1080 pd 60 Hz

Synsvinkel 170° (H) / 160° (V) ved C/R > 10
Billedforbedring Smartimage Lite

Skeermfarver 16,7 M

Vertikal opdateringshastighed 56Hz - 76Hz

Horisontal frekvens 30kHz - 83kHz

sRGB JA

DVI (digital), VGA (Analog),

Inputsignal HDMI (pa modellerne 227E3LH, 227E3LPH)
Inputsignal Separat synk., synk. pa gren
227E3L: @/v ©/a /< /0K Q)
Brugerfunktioner 227E3LH:  @/v ©/A 10/ < /0K 0)
227E3LPH: &p/v ©/A SENSOR/ /0K Q)
S50 i Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk,

portugisisk og tyrkisk

Andre funktioner

Kensington-las

"Plug & Play" kompatibilitet

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

Teendt-tilstand

Energiforbrug
(EnergyStar 5.0 testmetode)

-5/ 420

227E3L: 21,8 W (typ.)

227E3LH: 218 W (typ.), 27 W (maks.)

227E3LPH: 21,8 W (typ.), 24 W (maks.)

AC AC AC
indgangsspaending indgangsspeaending indgangsspaending

ved 100VAC +/-
S5VAC, 50Hz +/-
3Hz

ved 115VAC +/-
5VAC, 60Hz +/-
3Hz

ved 230VAC +/-
S5VAC, 50Hz +/
-3Hz

Normal funktion (typ.)

18,4 W

184 W

18,5W
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Sovetilstand 0,5W 0,5W 0,5W

Fra 0,5W 0,5W 0,5W
AC AC AC
indgangsspaending indgangsspeaending indgangsspaending

Varmetab* ved 100VAC +/- ved 115VAC +/- ved 230VAC +/-
5VAC, 50Hz +/- S5VAC, 60Hz +/- S5VAC, 50Hz +/
3Hz 3Hz -3Hz

Normal drift 62,8 BTU/t 62,8 BTU/ 63,14 BTU/t

Sovetilstand 1,71 BTUA 1,71 BTU 1,71 BTUA

Fra 1,71 BTU/ 1,71 BTU/ 1,71 BTU/A

Stremdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50/60Hz

Produkt uden fod (B x H x D)

534,34 x 407,9 x 216 mm

Produkt uden fod (B x H x D)

534,34 x 335,89 x 41,1 mm

Produkt med fod 4,01kg
Produkt uden fod 347kg
Produkt med emballage 417kg

Myndighedernes godkendelser

Temperaturomrade (drift) 0°C til 40°C
Temperaturomrade o i o
(Ikke drift) -20°C il 60°C
Relativ fugtighed 20% til 80%
Hoide Betjening: + 3.658 m (12.000 fod)
) lkke drift: + 12.192 cm (40.000 fod)
MTBF 30.000 timer
ROHS JA
EPEAT Silver (www.epeat.net)
Emballage 100 % genbrugelig

CE Mearket, FCC Klasse B, GOST, SEMKO, TCO Godkendt,
UL/cUL, BSMI, ISO9241-307

Farve Sort (bagside), Bla (forside)
Overflade Blank
& Bemerk

—_

for registreringsstatus i dit land.

N

version af brochuren.

EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net

Disse data kan @&ndres uden varsel. Ga til www.philips.com/support for at hente den seneste
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5. Tekniske specifikationer

5.1 Oplesning og forudindstillede
funktioner

El Maksimal oplesning
1920 x 1080 ved 60 Hz (analogt indgang)
1920 x 1080 ved 60 Hz (digital indgang)
Bl Anbefalet opl@sning

1920 x 1080 ved 60 Hz (digital indgang)

480i 720x 480 | SD |60
480p 720x480 | SD |60
576i 720x 576 | SD |50
576p 720x 576 | SD |50
720p | 1280x 720 | HD |50, 60
10801 | 1920 x 1080 | HD |50, 60
1080p | 1920 x 1080 | HD |24,25, 30, 50, 60

& Bemerk

Bemaerk venligst at din skaerm virker bedst med
native oplasning pa 1920 X 1080 ved 60Hz. For
at opna den bedste skaermkvalitet, bedes du
venligst bruge denne oplgsning.
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6. Stromstyring

6. Stremstyring

Hvis der er installeret et skaermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skeermen automatisk
nedsatte stremforbruget, nar den ikke bruges.
Nar input fra tastatur, mus eller anden input-
enhed registreres, "vagner" skeermen automatisk
igen. Nedenstaende tabel viser denne
automatiske energisparefunktions strgmforbrug
og signalering:

VESA .
tilstand Video | V synk | L synk | Opbrugt strem | LED Farve
Aktiv TIL Ja Ja  |<21,8W (norm.) Hvid
. . . Hvid
Sovetilstand | FRA [ Nej Nej | <05W (norm.) i)
Kontakt Fra| FRA - - < 05W (norm.) FRA

Folgende opsatning bruges til at male
skeermens strgmforbrug.

* Indbygget oplasning: 1920 x 1080
*  Kontrast: 50%
*  Lysstyrke: 250 nits

* Farvetemperatur: 6500k med fuldt, hvidt
manster

@ Bemark
Disse data kan a&ndres uden varsel.
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/. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery

¥ and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user
in focus that also minimizes the impact on the
climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* \Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is now
requested by users and IT-manufacturers all
over the world. About 50% of all displays world-
wide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver: 2.1

I[n Technology for you and the planet
CERTIFIED




EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
@ Environmental Assessment Tool)

program evaluates computer

desktops, laptops, and monitors
based on 51 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

«  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

e EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

» EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

«  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

*  2006/95/EC (Low Voltage Directive).

« 2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on I1SO9000
level.

The product also comply with the following
standards

+ 1S0O9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

* (S EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

¢ MPR-II (MPR1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

«  TCO CERTIFED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystargov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

e Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



7. Lovmassige oplysninge

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spsacifi-
cally stated that it is a Class A device on the specification labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 meters). The ussr of the
device is obliged to taks all staps necessary to remove sources of intarfarence o tels-
communication or athar devices.

Pokud nani na typowam &tithu poditade uvedeno, 8 spada do do fidy A podis EN 55022,
spadd automaticky do tfidy B podie EN 55022, Pro zafizeni zatazrend do thidy A (chranné
péamo 30m) pedie EN 55022 platl nésledujicd. Dojde-ll k rufenl telekormumikatnich nabo
Fnich zafizeni je ufivatel povinnen prowdst takovd opatfgnl, aby rulieni odstranil.

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer; and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Usradzeide powiano byd zasibane = galazds 2 preybacsnym obwodem ochronmym (gniasdo 2
kolkvenh, Wapdtpracugnce ze soby uresdeenia (komputer, monator, drokarkap powinny by msilome
# i sk rddla.

Instalacja elektrycoma pomieszceenta powine mwiesas w preewadsie Browym reeeraows achrong
proec] swarciami, w postaci bezprecenika o warkedcl mamionowe] me wigkszej nit 16A {amperew ).
W eelu catkowitego wylacrenia urzadeenta 2 siect zasilania, naledy wyjat wivezks kabla
sasllaigeego 2 gmazdka, kidre powlmnno ssjdowad s w pobliag ureadeenda 1 byd 2atwo dostgpie.

Znak berpicezefsiwa "B" potwiendea spodnost uresdrenia 2 wymaganiami beepiecefiuiwa
ukytkowanda yawartvitl w FR-UAT-H2107 1 PN-REAM2S].

Pozostale instrukcje bezpieczensiwa

* Mie maledy whwad wiyceek adaptenowvch lub wuwad kedka abwodi ochronnego = wiyceki.
Tedelt komsecene jest whycie preedbutacza e naledy whyd preediuiace 3-avlowego 2
prawidbowa polsceonymm preewodem ochmannym.

System kompulerowy naleky sabespieceyd preed naphyme, chwilowymi werostami lub spad-
kami napsgcia, wiywijae eliminatan preepies, urrasdzemia dopasawajacege leh
berraklaceniowegn Frodia easilania

Maleiy |||1vm|t sl albvy e o lekaloona kablsch systerni kull'qmll:uml.gfr arax aby kable me
byly umieszczone w |n||.| cu, gideie medna byloby na nie nadepiywad lub porylst sig o me.

* Mie maledy rozlewad napogia am meych plyaio s systeim kampubenowy.

Mie maleiy wpychal fadnveh preedmictio: do abwendw systenu kemputercwega, plyi moke
ta spowodowai pegar lub porasenie prydem, poprees swancie elemeniaw wewngirznych

- Syt kompulenowy powiiac enapdowad sl 2 dala od greejnikbo o deddel clepla. Porsdro,
re paledy blakawas atwerdw wentylacyjeych. Naledy unikac kladeensa luznpeh papseriw posd

kampriter sz amisseczania kampabera wociasnym migjsew bex mazliwass cyrkalacii powi-
elnm wokol nisgoe.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOST]
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERIIEE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Réntgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
Il @ 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt /0dB (A) oder
weniger.

7N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



7. Lovmassige oplysninger
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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8. Kundeservice og garanti

8.1 Philips' regler ved pixeldefekter
pa fladskerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skeerme dog uundgdelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skeerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skaerm veaere defekte. Desuden satter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
gelder i hele verden.

sub-pixler sub-pixler  sub-pixler

T

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primerfarverne red, gron og
bld. Ndr mange pixler settes sammen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser, fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er marke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og marke sub-pixler fremstar som
enkelte pixler i andre farver.

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optreeder pa
skeermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skaermbilledet, nar skaermen viser et
merkt menster. Der er fglgende typer defekte
lyse prikker.

En teendt red, gren eller bla sub-pixel.

I C

To sammenliggende tendte sub-pixler:
- Red + Bla = Lilla

- Red + Grgn = Gul

- Gron + Bla = Cyan (Lysebld)

Tre sammenliggende tendte pixler (en hvid
pixel).




6 Bemaerk

En red eller bla lys prik skal vaere mere end 50
procent lysere end de omkringliggende prikker,
mens en gren lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte morke prikker

Defekte marke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er “slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
nar skaermen viser et merkt menster. Der er
felgende typer defekte marke prikker.

4 I N

Taetsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for teetsiddende pixeldefekter.

a )

N

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skeerm i en Philips
fladskaerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
felgende tabeller.

ACCEPTABELT NIVEAU

BRIGHT DOT-DEFEKTER

1 teendt sub-pixel 3
2 sammenliggende taendte sub-pixler 1
Tre sammenliggende taendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

1 merk sub-pixel 5 eller feerre

2 sammenliggende mearke sub-pixler 2 eller feerre

3 sammenliggende mgarke sub-pixler 0

Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller feerre

@ Bemark
1.
2.

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 15O9241-307 (1509241-307: Testmetoder for

ergonimiske krav, analyse og overensstemmelse pd elektroniske visuelle skaerme)




8.2 Kundeservice og garanti

For oplysninger om garantidaekning og geeldende stgttekrav i dit omrdde, bedes du besgge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tlf Pris

Germany Siemens 1&S +49 01803 386 853 € 0,09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 /85 €010

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 € 0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007

Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter ASC Kundeservice tlf
Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
oo f‘egm NA Kim Tec d.0o, +381 1120 70 684
Slovenia NA PC H.and +386 1 530 08 24
Ulkfie NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
S NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter
Brazil

: Vermont
Argentina

Kundeservice tlf
0800-7254101

0800 3330 856

Kontaktoplysninger til Kina:
Kina
Kundeservice tlf: 4008 800 008

Kontaktoplysninger til NORDAMERIKA:

Land Callcenter ASC Kundeservice tIf
US.A. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696




Kontaktoplysninger til APMEA:

Land Callcenter ASC Kundeservice tlf
Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PLILIPS to 56677
: : : : : Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA SylvaraTechnologies Pty Ltd 086 0000 888
cnited Arab | AL SHAHD COMPUTER LL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
EPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA C Ltd +84 5113.562666 Danang City
S +84 5113.562666 Can tho Province
I : (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no dllstrlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
e Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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9. Fejlfinding og FAQ

9.1 Fejlfinding

Denne side omhandler problemer, som kan
klares af brugeren selv. Hvis problemet stadig er
der, efter at du har prevet disse lgsninger, skal
du kontakte Philips" kundeservice.

1 Almindelige problemer

Intet billede (stremdiode lyser ikke)
* Kontroller, at ledningen er sat i
stikkontakten og bag pa skaermen.

e Kontroller fgrst, at stremkontakten foran
pa skermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
* Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede
stikben pd signalkablets stik. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

» Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

* Tjek, om skaermkablets stikben er bgjede.

* Kontroller, at der er teendt for computeren.

AUTO (AUTOM.) knappen virker ikke

* Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.
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& Bemark
Den automatiske funktion er ikke ngdvendig i
DVI digital-tilstand.

Synlige tegn pa rog eller gnister
* Forsgg ikke selv at fejlfinde

e Traek straks skermens stik ud af
stikkontakten

* Kontakt straks en reprasentant fra Philips
kundeafdeling.

H Billedproblemer

Billedet er ikke centreret
* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock
(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skaermen
* Tjek at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

£ =

L

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Billedet er sloret, uklart eller for morkt
* Indstil kontrasten og lysstyrken i OSD.



Der forbliver et “efterbillede”,
“brandmerkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

» Uafbrudt visning af et stilbillede over
lzngere tid, kan fordrsage “brandmerker”,
ogsa kendt som “efterbilleder” eller
“spagelsesbilleder” pd skaermen.
“Braendmaerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt fenomen
i LCD skermteknologi. | de fleste tilfeelde vil
“brandmeerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skermen er blevet slukket.

* Sgrg altid for at aktivere en pauseskaerm,
der bevaeger sig, ndr skeermen efterlades
uden at blive anvendt.

* Du skal altid bruge en pauseskaerm eller
et andet program, der opdaterer skaermen
regelmassigt, hvis LCD skarmen viser
statisk materiale | lengere perioder.

* Alvorlig “brandmarkerne”- eller
“efterbillede”- eller “spagelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvraenget. Tekst er utydelig eller

sloret.

* Indstil pc’ens skeermoplasning som
skeermens anbefalede, native oplasning.

Der ses rede, bla, marke og hvide pletter pa

skaermen

*  De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Taendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Teendt” lyset med
Strgmdiode i OSD-menuerne.

For yderligere hjeelp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.
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9.2 Ofte stillede spargsmal om

SmartControl Lite

SP1. Jeg har udskiftet skermen pa en pc

til en anden skarm, og nu fungerer

SmartControl Lite ikke lengere. Hvad

skal jeg gore!?

Sv..  Genstart din pc og se, om SmartControl
Lite fungerer nu. Ellers skal du afinstallere
og geninstallere SmartControl Lite for at
sikre, at den korrekte driver er installeret.

SP2. SmartControl Lite fungerede fint
tidligere, men nu virker programmet
ikke lengere. Hvad skal jeg gore?

Sv.: Hvis nogle af de felgende handlinger har
veeret udfert, skal skeermdriveren maske
geninstalleres.

* Videografikadapteren er blevet udskiftet

med en anden
» Opdater videodriver

* Aktiviteter i OS som f.eks. servicepakke
eller programrettelse

*  Opdater Windows og opdater skeerm- og/
eller videodriver

*  Windows blev startet med strgmmen til
skaermen slaet fra eller afbrudt.

* For at finde ud af dette, skal du klikke
pa My Computer (Denne Computer)
og derefter pa Properties (Egenskaber)
-> Hardware -> Device Manager
(Enhedshandtering).

* Huvis du ser “Plug and Play Monitor" (Plug
& Play skaerm) under Monitor (Skarm), skal
du geninstallere. Afinstallér SmartControl
Lite og geninstallér det.

SP3. Efter installation af SmartControl Lite
sker der ingenting, selv om jeg klikker pa
fanen SmartControl Lite og venter, eller
der vises en fejlmeddelelse. Hvorfor?

Sv..  Det skyldes muligvis, at din grafiske
adapter ikke er kompatibel med
SmartControl Lite. Hvis grafikadapteren
er en af ovennavnte maerker, skal
du preve at downloade den mest



SP4.

Sv.:

opdaterede grafikadapterdriver fra det
pagaldende firmas hjemmeside.

Installer driveren. Afinstallér SmartControl
Lite og geninstallér det igen.

Hvis det stadig ikke virker, er vi bange for,
at grafikadapteren ikke understottes. G2 til
Philips hjemmeside og kontrollér, om der
findes en nyere driver til SmartControl
Lite.

Nar jeg klikker pa Product Information
(Produktinformation), ses kun nogle af
oplysningerne. Hvad er der sket!?

Det kan veere, at din
grafikkortadapterdriver ikke er den

mest opdaterede version, som fuldt ud
understatter DCC/CI greensefladen. Prav
at downloade den mest opdaterede
grafikkortadapterdriver fra det
pagaldende firmas hjemmeside. Installer
driveren. Afinstallér SmartControl Lite og
geninstallér det igen.

Attention

Theft mode enabled

SP5 Jeg har glemt min PIN-kode til Theft

Sv.:

Deterrence (Anti-tyveri) funktionen.
Hvad gor jeg?

Philips servicecenter forbeholder sig
retten til at bede om legitimation og
godkendelse, for at kunne etablere
skaermens ejer.

Bemeaerk venligst at anti-tyveri-funktionen
leveres som gratis ekstraudstyr. Det
eneste ansvar for den individuelle bruger
eller organisation, er at administrere
PIN-koden. Hvis PIN-koden glemmes, kan
Philips kundeservicecenter nulstille koden
for at almindeligt gebyr, nar brugeren har
bekreeftet ejerskab af udstyret. Bemaerk
venligst at denne handling ikke er daekket
af standard garantien.
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9.3

SP1:

Generelle FAQ

Hvad skal jeg gare, hvis skeermen under
installationen viser “Cannot display
this video mode” (Kan ikke vise denne
videotilstand)?
Den anbefalede oplasning pa denne
skeerm: 1920 x 1080 pa 60 Hz.
Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte for.

| Windows Start Manu (Windows
Startmenuen), vaelg Settings/Control Panel
(Indstillinger/Kontrolpanel). | Control

Panel (Kontrolpanel)-vinduet veelg Display
(Skeerm)-ikonet. | Egenskaber for Skaerm-
vinduet veelg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet “desktop area” (skrivebordsomrade),
skal du stille justeringsbjeelken pa
1920x1080 pixler.

Abn “Advanced Properties” (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

Genstart computeren og gentag trinene
2 og 3 og bekraft, at pc'en er indstillet til
1920x1080 ved 60 Hz

Luk for computeren, frakobl den gamle
skerm og genforbind Philips LCD skaermen.

Teaend for skeermen og derefter for pc'en.

SP2: Hvad er den anbefalede

Sv.:

SP3:

opdateringshastighed pa LCD skaermen?
Den anbefalede opdateringshastighed

pa LCD skeerme er 60 Hz. | tilfeelde af
forstyrrelser pa skeermen skal du sztte
den op til 75 Hz og se, om dette flerner
forstyrrelserne.

Hvad er .inf og .icm filerne pé cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Dette er skeermens driverfiler. Installer
driverne I henhold til brugervejledningen.
Computeren kan bede dig om
skermdrivere (.inf og .icm filer) eller om
en driverdisk, nar du installerer skaeermen



SP4:

Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8
Sv.:

forste gang. Indszet (medfelgende cd-rom)
I pakken I henhold til vejledningerne.
Skeermdrivere (.inf og .icm filer) installeres
automatisk.

Hvordan justerer jeg oplesningen?
Skarmkortet/grafikdriveren og skeermen
bestemmer sammen oplgsningerne til
radighed. Du kan veelge den gnskede
oplasning under “Egenskaber for Skaerm” |
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skaermen!?

Sa skal du blot trykke pa OK og derefter
veelge “Reset” (Nulstil) for at gd tilbage til
de oprindelige fabriksindstillinger.

Er LCD-ska&rmen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udsaette
skeermens overflade for kraftige sted.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sd

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renger jeg LCD skarmens
overflade?

Til normal renggring skal du blot anvende
en ren, blad klud. Til kraftigere rengering
skal du bruge isopropylalkohol. Brug

ikke andre oplgsningsmidler sdsom
ethylalkohol, ethanol, acetone, hexan osv.

: Kan jeg @ndre skaermens farveindstilling?

Ja, du kan a@ndre farveindstillingen via
OSD pd felgende mdde:
Tryk pd “OK" for at vise OSD (On Screen
Display) menuen

Tryk pd “Down Arrow" (Ned-pil) for
at veelge indstillingen “Color” (Farve),
og tryk derefter pa “OK" for at angive
farveindstillingen. Der er tre indstillinger,
som vist nedenfor.

1. ColorTemperature (Farvetemperatur) -
Med indstillinger i 6500K omradet virker
skermen “varm” med en rgd-hvid
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arvetone, mens en 9300K temperatur
giver en “kold bla-hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer; skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan veelge sin foretrukne
farveindstilling ved at indstille den rede,
gronne og bld farve.

& Bemark

En malning af farven pa lys, der udstrales fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rgde,
hojere temperaturer sasom 9300K er bla.
Neutral temperatur, 6504K; er hvid.

SP9: Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
veere ngdvendig for at kunne forbinde
skeermen til dit Mac-system.Vi anbefaler,
at du kontakter Philips salgsreprasentant
for yderligere oplysninger.

SP10: Er Philips LCD skarme “Plug & Play”?

Sv.:  Ja, skeermene er “Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX
og Linux

SP11: Hvad er “billedkleebning” eller
“billedindbraending” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
lzngere tid, kan fordrsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spagelsesbilleder” pa skaermen.
“Braendmaerker”, “efterbilleder”, og
“spggelsesbilleder” er et velkendt
fenomen i LCD skaermteknologi. | de
fleste tilfelde vil “brandmaerkerne” eller
“efterbilledet” eller “spogelsesbilledet”

Sv.:

Sv.:



forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskaerm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskaerm

eller et andet program, der opdaterer
skeermen regelmaessigt, hvis LCD
skaermen viser statisk materiale i lengere
perioder.

O Advarsel

Alvorlig “brandmeerkerne’- eller “efterbillede’-
eller “spagelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennzvnte skade
er ikke dekket af garantien.

SP12: Hvorfor viser skermen ikke skarp tekst?

Sv.:

Hvorfor viser den forrevne tegn?

Din LCD monitor virker bedst pa dens
native oplgsning pa 1920 x 1080 ved

60 Hz. Brug denne oplasning for at opna
det bedste billede.
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